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ABSTRACT 

 

 

Power system analysis software used to determine the amount use of power of 

the electrical power network for utility, industrial, and commercial industries. Along 

with all of the recent technological advances, there have been similar advances in power 

system analysis software. Engineers use this software to design, operate and control 

power systems. Such software allows engineers to solve power system analysis problems 

more easily.   This analysis is intended as introductory information for Petronas Gas 

plant engineering wanting to acquire power system analysis software. Additionally, this 

analysis addresses how such software can be applied in the Petronas Gas industrial plant. 

This analysis is more focuses on the power flow analysis. A power flow will calculates 

the voltage drop on each feeder, the voltage at each bus, and the power flow in all branch 

and feeder circuits. It is worked by using the software of SKM Power Tools for 

Windows.  
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ABSTRAK 

 

 

Perisian analisis sistem kuasa digunakan untuk menentukan penggunaan kuasa 

jumlah jaringan kuasa elektrik untuk utiliti, industri, dan industri-industri perdagangan. 

Sepanjang dengan semua kemajuan-kemajuan teknologi mutakhir, di sana telah sama 

kemajuan dalam perisian analisis sistem kuasa. Penggunaan jurutera-jurutera mereka 

bentuk perisian ini, beroperasi dan sistem-sistem kekuatan kuasa. Perisian seumpama 

membenarkan jurutera-jurutera untuk menyelesaikan masalah-masalah analisis sistem 

kuasa lebih senang. Analisis ini adalah dimaksudkan maklumat yang serupa asas untuk 

kejuruteraan kilang Petronas Gas inginkan untuk memperolehi perisian analisis sistem 

kuasa. Tambahan pula, alamat-alamat analisis ini perisian yang bagaimana seumpama 

boleh digunakan dalam kilang perindustrian Petronas Gas. Analisis ini adalah lebih 

menumpukan pada analisis aliran kuasa. Satu wasiat aliran kuasa mengira susutan voltan 

di setiap penyuap, voltan di setiap bas, dan aliran kuasa dalam cawangan keseluruhan 

dan litar-litar penyuap. Ia dikerjakan dengan menggunakan perisian SKM Power Tools 

for Windows. 
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CHAPTER 1 

 

 

 

 

INTRODUCTION 

 

 

 

 

1.1 Introduction 

 

 

Power flow commonly referred to as load flow, are the backbone of power 

system analysis and design.  They are necessary for planning, operation, economic 

scheduling and exchange of power between utilities.  In addition, power flow analysis is 

required for many others analysis such as transient stability and contingency studies [1]. 

 

The availability of fast and large computers has somewhat eased the work load of 

the power system engineer. Routine calculation can now be accomplished more 

efficiently and more extensively. Advances in device and system modeling, as well as 

the developments I computational technique, have greatly enhanced the analysis and 

planning tasks [2]. 

 

The hand computational work to perform power system analysis is very complex, 

cumbersome, and time consuming. Power system analysis aid were first develop in the 

late 1920s. It provided the ability to determine system voltage levels during the normal 
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and emergency condition, and to determine the behavior of the power system analysis 

[4]. 

 

Today’s engineers have a wide variety of hardware and software tools to perform 

power system analysis. There are many software packages offered in power system 

analysis. Most software packages include the following calculations as basic features; 

load flow, short circuit, motor starting, and protective device coordination.  

 

 This analysis only addresses the power flow which is the most common software 

packages used in a Petronas Gas industry. SKM Power Tools is one of the software used 

for power flow analysis. The result will show all of the analysis needed. 

 

 

1.2 Objective 

 

 

The objective of this project are : 

  

i. To study the electrical power distribution for Petronas Gas Industrial   

Plant at Kerteh. 

 

ii. To model and simulate the load flow and analysis for single line diagram  

of Petronas Gas Kerteh by using SKM Power Tools software. 

 

 iii. To apply computer method for electrical power distribution for Petronas 

                        Gas Industrial Plant. 
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1.3 Scope of Project 

 

 

The scope of this project are : 

 

i. Case study on power system network (single line diagram) of Petronas  

Gas Kerteh. 

 

iii. Analyze the power flow analysis for trial system. 

 

iv. Model, simulate and analyze the power flow of electrical power system  

distribution in Petronas Gas using SKM Power Tools software. 

 

   

1.4 Thesis Outline 

 

 

 For the thesis outline, it has five chapters. All the progress elements are divided 

into chapters and the details of each chapter are as follows: 

 

i Chapter 1 

a. Introduction: Explain detail about the general information of this 

thesis. The problem statement is stated here along with the 

relevant solution. It’s to support the main objectives and the 

relevant of the proposed title. 

b. Objective: The goal of the project is stated in here. It’s consists of 

the aim that must be achieved at the end of the project. 

c. Scope of work: The flow of work that will be implemented in this 

project. This step by step flow work is to keep the project’s 

progress on track and to meet the objective. 

d. Thesis outline: The overall elements needed in the thesis. 
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ii. Chapter 2 

a. Literature review: The study on the others papers, journal, website 

citation and other dependable sources that related to the project. 

Literature review is crucial for every thesis not only to support the 

proposed title but also for guidelines and references on the 

conducted thesis. 

 

iii. Chapter 3 

a. Methodology:  Describe in details about the scope of project. In 

this part, every step on how to approach the solutions to overcome 

the stated problems is described in details. Its shows how the work 

will be done. The details such as flow chart, schematic diagram 

are shown in here. 

 

iv. Chapter 4 

a. Expected result: State the expected results that will be achieved at 

the end of the project. 

 

v. Chapter 5 

a. Conclusion: Conclude the project’s objectives and result achieved.  

The project success or failure is stated in here.  

b. Suggestion: Give suggestion for the future of this project. 
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CHAPTER 2 

 

 

 

 

LITERATURE REVIEW 

 

 

 

       

2.1 Introduction 

 

 

Literature review is a study on the others papers, journal, website citation and 

other dependable sources that related to the project.  It is crucial for every thesis not only 

to support the proposed title but also for guidelines and references on the conducted 

thesis. 

  

  

2.2 Petronas Gas Power System 

 

 

2.2.1 Introduction of Petronas Gas Power System 

 

 

 

 

Figure 2.1 Petronas Gas Kerteh 
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Petronas Gas is one of the 18 investor-owned independent power producers 

supplying power to the three main utilities.  There are also several mini utilities 

generating electricity or purchasing power from the main utilities for their own use and 

supply the excess power to consumers within certain dedicated areas.  Petronas Gas 

generates electricity by co-generation and supplies to customers within the Gebeng and 

Kerteh petrochemical industrial areas.  Petronas gas Kerteh generates about 1,228,540 

MWh using gas turbine and gas petroleum as a fuel and distribute power to the 

consumers [8]. 

 

 

 

Figure 2.2 Kerteh Petrochemical area 
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2.2.2 Petronas Gas Power Generation 

 

 

 

Figure 2.3 Flow of the Power Generation 

 

A gas turbine extracts energy from a flow of hot gas produced by combustion of 

gas or fuel oil in a stream of compressed air.  It has an upstream air compressor (radial or 

axial flow) mechanically coupled to a downstream turbine and a combustion chamber in 

between.  Gas turbine may also refer to just the turbine element [3]. 

Energy is released when compressed air is mixed with fuel and ignited in the 

combustor.  The resulting gases are directed over the turbine's blades, spinning the 

turbine, and mechanically powering the compressor.  Finally, the gases are passed 

through a nozzle, generating additional thrust by accelerating the hot exhaust gases by 

expansion back to atmospheric pressure [3]. 

As with all cyclic heat engines, higher combustion temperature means greater 

efficiency. The limiting factor is the ability of the steel, nickel, ceramic, or other 

materials that make up the engine to withstand heat and pressure.  Considerable 

engineering goes into keeping the turbine parts cool. Most turbines also try to recover 

exhaust heat, which otherwise is wasted energy. Recuperators are heat exchangers that  

http://en.wikipedia.org/wiki/Air_compressor
http://en.wikipedia.org/wiki/Axial_flow
http://en.wikipedia.org/wiki/Turbine
http://en.wikipedia.org/wiki/Turbine
http://en.wikipedia.org/wiki/Energy
http://en.wikipedia.org/wiki/Compressed_air
http://en.wikipedia.org/wiki/Fuel
http://en.wikipedia.org/wiki/Ignition_system
http://en.wikipedia.org/wiki/Combustor
http://en.wikipedia.org/wiki/Nozzle
http://en.wikipedia.org/wiki/Heat_engine
http://en.wikipedia.org/wiki/Fuel_efficiency
http://en.wikipedia.org/wiki/Recuperator
http://en.wikipedia.org/wiki/Heat_exchanger
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pass exhaust heat to the compressed air, prior to combustion. Combined cycle designs 

pass waste heat to steam turbine systems.  A combined heat and power (co-generation) 

uses waste heat for hot water production [3], [8]. 

Mechanically, gas turbines can be considerably less complex than internal 

combustion piston engines. Simple turbines might have one moving part: the shaft/ 

compressor/ turbine/ alternative-rotor assembly not counting the fuel system [3]. 

More sophisticated turbines (such as those found in modern jet engines) may 

have multiple shafts (spools), hundreds of turbine blades, movable stator blades, and a 

vast system of complex piping, combustors and heat exchangers [3]. 

As a general rule, the smaller the engine the higher the rotation rate of the 

shaft(s) needs to be to maintain tip speed.  Turbine blade tip speed determines the 

maximum pressure that can be gained, independent of the size of the engine.  Jet engines 

operate around 10,000 rpm and micro turbines around 100,000 rpm [3]. 

Thrust bearings and journal bearings are a critical part of design.  Traditionally, 

they have been hydrodynamic oil bearings, or oil-cooled ball bearings.  This is giving 

way to foil bearings, which have been successfully used in micro turbines and auxiliary 

power units [3], [8]. 

 

2.3 Power System Analysis 

 

2.3.1  Introduction 

 

 

 The planning, design, and operation of electric power systems require continuing 

and comprehensive analysis in order to determine system performance and evaluate 

alternative system expansion plans.  Because of the increasing cost of system additions  

 

 

http://en.wikipedia.org/wiki/Combined_cycle
http://en.wikipedia.org/wiki/Steam_turbine
http://en.wikipedia.org/wiki/Combined_heat_and_power
http://en.wikipedia.org/wiki/Internal_combustion
http://en.wikipedia.org/wiki/Internal_combustion
http://en.wikipedia.org/wiki/Internal_combustion
http://en.wikipedia.org/wiki/Turbofan
http://en.wikipedia.org/wiki/Jet_engine
http://en.wikipedia.org/wiki/Thrust_bearing
http://en.wikipedia.org/wiki/Plain_bearing
http://en.wikipedia.org/wiki/Fluid_bearing
http://en.wikipedia.org/wiki/Ball_bearing
http://en.wikipedia.org/wiki/Foil_bearing
http://en.wikipedia.org/wiki/Auxiliary_power_unit
http://en.wikipedia.org/wiki/Auxiliary_power_unit
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and modifications, it is imperative that utilities consider a range of design options [2].  In 

order to the important of the power flow analysis, this chapter will discuss the about the 

theory related to the load flow analysis.  

 

 

2.3.2 Power Flow Analysis 

 

In power engineering, the power flow analysis is an important tool involving 

numerical analysis applied to a power system.  Unlike traditional circuit analysis, a 

power flow study usually uses simplified notation such as a one-line diagram and per-

unit system, and focuses on various forms of AC power (ie: reactive, real, and apparent) 

rather than voltage and current.  It analyses the power systems in normal steady-state 

operation.  There exist a number of software implementations of power flow studies [5]. 

The great importance of power flow or load-flow studies is in the planning the 

future expansion of power systems as well as in determining the best operation of 

existing systems.  The principal information obtained from the power flow study is the 

magnitude and phase angle of the voltage at each bus and the real and reactive power 

flowing in each line [5]. 

 

2.3.3  Basic of the power flow problem 

 

The load flow problem is an important tool for design and operation of 

distribution systems.  At the design stage, it is applied to ensure that the voltage and 

current standards are satisfactory under various conditions all over the network.  At the 

operation stage, load flow is used to ensure that voltages and currents are within the 

predefined ranges for expected loads [5].  

The goal of a power flow study is to obtain complete voltage angle and real 

power and voltage conditions.  Once this information is known, real and reactive power 

http://en.wikipedia.org/wiki/Power_engineering
http://en.wikipedia.org/wiki/Numerical_analysis
http://en.wikipedia.org/wiki/One-line_diagram
http://en.wikipedia.org/wiki/Per-unit_system
http://en.wikipedia.org/wiki/Per-unit_system
http://en.wikipedia.org/wiki/AC_power
http://en.wikipedia.org/wiki/Voltage
http://en.wikipedia.org/wiki/Electric_current
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flow on each branch as well as generator reactive power output can be analytically 

determined.  Due to the nonlinear nature of this problem, numerical methods are 

employed to obtain a solution that is within an acceptable tolerance [5].  In this 

problems, there are some solution that can be use to solve this problems.  This chapter 

only discuss detailed on the Newton-Raphson Method . 

 

2.3.4 Newton-Raphson Method 

 

Newton-Raphson method is found to be more practical and efficient for large 

power system.  The number of iterations required to obtain a solution is independent of 

the system size, but more functional evaluations are required at each iteration [5]. 

yin

yi1

yi2

Ii

Vi

V1

V2

Vn

yi0

 

 

Figure 2.4 Typical bus power system 

 

Figure 2.4 shown the typical bus power system.  Base on the power flow 

equation, when the current entering bus 1, it can be rewritten in terms of the bus 

admittance matrix as 

n

j

jiji VYI
1

          (2.1) 

 

The typical element Yij is 
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ijijijijijijijijij jBGYjYYY sincos      (2.2) 

 

The voltage at a typical bus I of the system in polar form is 

 

iiiiii jVVV sincos        (2.3) 

 

Expressing Equation (2.1) in polar form, we have 

 

jij

n

j

jiji VYI
1

        (2.4) 

 

The complex conjugate of the power injected at bus I  is 

 

n

j

jiji

iiii

VYV

IVjQP

1

*

*

         (2.5) 

Substitute Equation 2.4 into Equation 2.5 we get 

ijij

n

j

jiij

jij

n

j

jijii

n

j

jijiii

VVY

VYV

VYVjQP

1

1

1

*

      (2.6) 

Separating Equation 2.6 into real and reactive parts, we obtain 

 

ijij

n

j

jiiji VVYP
1

cos        (2.7) 

ijij

n

j

jiiji VVYQ
1

sin        (2.8) 
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Equation 2.7 and 2.8 constitute a polar form of the power flow equations.  When 

j is set to be equal to i in Equation 2.7 and 2.8 and the corresponding terms are separated 

from the summations, we obtain; 

 

ijij

n

ij
j

jiijiiii VVYGVP
1

2
cos       (2.9) 

ijij

n

ij
j

jiijiiii VVYBVQ
1

2
sin       (2.10) 

 

Let Pgi denote the scheduled power being generated at bus I and Pli denote the 

scheduled power demand of the load at the bus. Then, Pi,sch is the net scheduled power 

being injected into the network at bus i. The power mismatches for the typical load bus I  

is; 

calciigicalcischii PPPPPP ,,,        (2.11) 

calciigicalcischii QQQQQQ ,,,        (2.12) 

 

Mismatches occur when the calculated values Pi,calc and Qi,calc do not coincide 

with the schedule values. If the calculated values Pi,calc and Qi,calc match the scheduled 

values Pi,sch and Qi,sch perfectly, then we say the mismatches iP  and iQ are zero at bus 

i. 

Equation 2.9 and Equation 2.10 constitute a set of non-linear algebraic equations 

in terms of the independent variables, voltage magnitude in per-unit, and phase angle in  

 

radians. Expending the equations in Taylor’s series about the initial estimate and 

neglecting all higher order terms yields the Newton-Raphson power flow equations: 
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 (2.13) 

 

The diagonal elements of J11 are 

 

ijij

n

ij
j

jiij

i

i VVY
P

1

sin       (2.14) 

 

By comparing this equations for Qi in Equation 2.10 we obtain 

 

 iiii

i

i BVQ
P 2

        (2.15) 

 

The off - diagonal elements of J11 are 

       

 ijijjiij

j

i VVY
P

sin       (2.16) 

 

The diagonal elements of J21 as follows  

 

 
ijij

n

ij
j

jiij

i

i VVY
Q

cos
1

      (2.17) 

 

By comparing this equations for Pi in Equation 2.9 we obtain 
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iiii

i

i GVP
Q 2

         (2.18) 

 

The off - diagonal elements of J21 as follows  

 

ijijjiij

j

i VVY
Q

cos       (2.19) 

 

The diagonal elements of J12 as follows  

 

 ijij

n

ij
j

ijjiiii

i

i

i YVGVV
V

P
V cos2

1

    (2.20) 

 

Comparing Equation 2.20 with Equation 2.17 and Equation 2.18 yields 

 

 iiiiiii

i

i

i

i

i GVPGV
Q

V

P
V

22
2      (2.21) 

 

The off - diagonal elements of J12 as follows  

 

 ijijiijj

j

i

j VYV
V

P
V cos       (2.22) 

  

Comparison with Equation 2.19 yields 

 

 
j

i

j

i

j

Q

V

P
V         (2.23)

    

Finally, the diagonal and off-diagonal of sub matrix J22 are as follows 
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 iiiiiii

i

i

i

i

i BVQBV
P

V

Q
V

22
2      (2.24) 

 

 
j

i

ijijiijj

j

i

j

P
VYV

V

Q
V sin      (2.25) 

 

2.4 Power System Modeling 

 

 

 All analysis in the engineering sciences starts with the formulation of appropriate 

models. A model, and in power system analysis we almost invariably then mean a 

mathematical model, is a set of equations or relations, which appropriately describes the 

interactions between different quantities in the time frame studied and with the desired 

accuracy of a physical or engineered component or system.  Hence, depending on the 

purpose of the analysis different models of the same physical system or components 

might be valid [7]. 

 

 In principle, the complete telegraph equations could be used when studying the 

steady state conditions at the network nodes.  The solution would then include the initial 

switching transients along the lines, and the steady state solution would then be the 

solution after the transients have decayed.  However, such a solution would contain a lot 

more information than wanted and, furthermore, it would require a lot of computational  

effort.  An algebraic formulation with the lumped-circuit line model, would give the 

same result with a much simpler model at a lower computational cost [7]. 

  

It is quite obvious what model that is the appropriate one, but in many 

engineering studies the selection of the “correct” model is often the most difficult part of 

the study.  It is good engineering practice to use as simple models as possible, but of 

course not too simple.  If too complicated models are used, the analysis and 

computations would be unnecessarily cumbersome.  Furthermore, generally more 
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complicated models need more parameters for their definition and to get reliable values 

of these require often extensive work [7]. 

 

 

2.4.1 Line and Cable 

 

 

 The equivalent π-model are recognize in order to make it easy to analyze.  The 

general distributed model is characterized by the series parameters. 

 

R’  = series resistance/km per phase (Ω/km) 

X’  = series reactance/km per phase (Ω/km) 

And the shunt parameters 

B’  = shunt susceptance/km per phase (siemens/km) 

G’ = shunt conductance/km per phase (siemens/km) 

 

as depicted in Figure 2.5.  The parameters above are specific for the line or cable 

configuration and are dependent on conductors and geometrical arrangements [7] 

 

From the circuit in Figure 2.5 the telegraph equation is derived, and from this the 

lumped-circuit line model for symmetrical steady state conditions, Figure 2.6.  This 

model is frequently referred to as the π-model, and it is characterized by the parameters 

[7]; 

    

Zkm = Rkm + jXkm = series impedance (Ω)  

= shunt admittance (siemens)  
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Figure 2.5 Equivalent circuit of a line element of length dx 

 

 

 

Figure 2.6 Lumped-circuit model (π-model) of a transmission line between nodes k  

and m 

 

In the following most analysis will be made in the p.u. system.  For impedances 

and admittance capital letters indicate that the quantity is expressed in ohms or siemens, 

and lower case letters that they are expressed in p.u. In these lecture notes complex 

quantities are not explicitly marked as underlined.  This means that instead of writing 

zkm we will write zkm when this quantity is complex.  However, it should be clear from  

the context if a quantity is real or complex.  Furthermore, we will not always use specific 

type settings for vectors.  Quite often vectors will be denoted by bold face type setting, 

but not always.  It should also be clear from the context if a quantity is a vector or a 

scalar [7]. 
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When formulating the network equations the node admittance matrix will be used 

and the series admittance of the line model is needed 

 -  +                (2.3.1) 

With 

 =          (2.3.2) 

And 

 =           (2.3.3) 

 

For actual submitter the series reactance  and the series resistance  are 

both positive, and consequently  is positive and  is negative.  The shunt 

susceptance   and the shunt conductance   are both positive for real line 

sections.  In many cases the value of   is so small that it could be neglected [7]. 

 

The complex currents  and  in Figure 2.2 can be expressed as functions of 

the complex voltages at the branch terminal nodes k and m [7]; 

= ) +          (2.3.4) 

= ) +        (2.3.5) 

 

where the complex voltages are 

 

=           (2.3.6) 

=           (2.3.7) 

 

This can also be written in matrix form as 

 

=       (2.3.8) 
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As seen the matrix on the right hand side of equation (2.3.8) is symmetric and the 

diagonal elements are equal. This reflects that the lines and cables are symmetrical 

elements [7]. 

 

 

2.4.2 Transformer 

 

 

 We will start with a simplified model of a transformer where we neglect the 

magnetizing current and the no-load losses.  In this case the transformer can be modeled 

by an ideal transformer with turns ratio  in series with a series impedance  which 

represent resistive losses and the leakage reactance, see Figure 2.7 [7]. 

 

 

Figure 2.7 Transformer model with complex ratio =  

 

 

2.4.2.1 In-Phase Transformer 

 

 

 

 

Figure 2.8 In-phase transformer model 
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Figure 2.8 shows an in-phase transformer model indicating the voltage at the 

internal - non-physical - node p.  In this model the ideal voltage magnitude 

ratio (turns ratio) is [7], 

                               (2.3.9)  

 

, this is also the ratio between the complex voltages at nodes k and p, 

 

 

 

There are no power losses (neither active nor reactive) in the ideal transformer 

(the k - p part of the model), which yields 

 

 +  = 0                                (2.3.11) 

 

Then applying equations (2.3.9) and (2.3.10) gives 

 

 

 

 

Figure 2.9 Equivalent π model for in-phase transformer 
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which means that the complex currents  and  are out of phase by 180◦ since  

∈ R. Figure 2.5 represents the equivalent π-model for the in-phase transformer in Figure 

2.8. Parameters A, B, and C of this model can be obtained by identifying the coefficients 

of the expressions for the complex currents  and  associated with the models of 

Figures 2.8 and 2.9.  Figure 2.8 gives [7]; 

 

             (2.3.13) 

              (2.3.14) 

 

Or in metric form: 

 

=                            (2.3.15) 

 

As seen the metric on the right hand side of eq. (2.3.15) is symmetric, but the diagonal 

elements are not equal when   1.  Figure 2.9 provides mow the following [7]: 

 

                (2.3.16) 

               (2.3.17) 

 

Or in metric form 

 

=                 (2.3.18) 

 

Identifying the matrix elements from the matrices in equations (2.3.15) and (2.3.18) 

yields 

 

A =                      (2.3.19)     

B =                   (2.3.20) 

C = (1 − )                              (2.3.21) 
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Figure 2.10 Phase-shifting transformer with  =   

 

Phase-shifting transformers, such as the one represented in Figure 2.10, are used 

to control active power flows; the control variable is the phase angle and the controlled 

quantity can be, among other possibilities, the active power flow in the branch where the 

shifter is placed.  A phase-shifting transformer affects both the phase and magnitude of 

complex voltages  and , without changing their ratio, 

 

 

 

Thus, and  =  using equations (2.3.11) and (2.3.22), 

 

 

As with in-phase transformers, the complex currents   and  can be 

expressed in terms of complex voltages at the phase-shifting transformer terminals: 

 

            (2.3.24) 

             (2.3.25) 

 

Or in metric form 
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=               (2.3.26) 

 

If no parallel paths exist, the phase-shifting has no significance. The introduced 

phase-shift can in such a case been seen as a shift of the phase angle of the reference 

node. Y-Δ connected transformers are often used to provide zero-sequence de-coupling 

between two parts of the system, and not for active power flow. For active power flow 

control usually phase-shifting much lower than 30◦ is needed. Often the phase-shifting 

could be varied to cope with different loading situations in the system. 

 

 

2.4.3 Shunt Element 

 

 

The modeling of shunt elements in the network equations is straight forward and 

the main purpose here is to introduce the notation and the sign convention to be used 

when formulating the network equations. As seen from Figure 4.7 the current from a 

shunt is defined as positive when injected into the bus. This means that, 

 

                              (2.3.27) 

 

with  being the complex voltage at node k. Shunts are in all practical cases either 

shunt capacitors or reactors. From eq. (2.3.27) the injected complex power is; 

                        (2.3.28) 
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Figure 2.11 A shunt connected to bus k 

 

 

2.4.4 Loads 

 

 

Load modeling is an important topic in power system analysis. When 

formulating the load flow equations for high voltage systems, a load is most often the in 

feed of power to a network at a lower voltage level, for example a distribution network. 

Often the voltage in the distribution systems is kept constant by controlling the tap-

positions of the distribution transformers which means that power, active and reactive, in 

most cases can be regarded as independent of the voltage on the high voltage side. This 

means that the complex power   is constant, for example independent of the 

voltage magnitude . Also in this case the current is defined as positive when injected 

into the bus, see Figure 4.8. In the general case the complex load current can be written 

as [7]; 

 

                   (2.3.29) 

 

where the function  describes the load characteristics. More often the load 

characteristics are given for the active and reactive powers; 

 

                  (2.3.30) 
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                  (2.3.21) 

 

 

Figure 2.12 Model of a load connected to bus  

 

 

2.4.5  Generators 

 

 

 Generators are in load flow analysis modeled as current injections, as shown in 

figure below.  In steady state a generator is commonly controlled so that the active 

power injected into the bus and the voltage at the generator terminals are kept constant.  

This will be elaborated later when formulating the load flow equations.  Active power 

from the generator is determined by the turbine control and must of course be within the 

capability of the turbine generator system. Voltage is primarily determined by the 

reactive power injection into the node, and since the generator must operate within its 

reactive capability curve it is not possible to control the voltage outside certain limits.  

The reactive capability of a generator depends on a number of quantities, such as active 

power, bus voltage and other operating conditions [7]. 
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Figure 2.13 Model of a generator connected to bus k. 

 

 

2.5 Summary 

 

 

 The power flow problem is an important tool for design and operation of 

distribution systems  The goal of a power flow study is to obtain complete voltage angle 

and real power and voltage conditions.  To obtain the power flow, hand calculation also 

useable such as Newton-Raphson, Fast-Decouple and also Gauss Seidel method.  Today, 

it have a lot of software to analysis the power flow.  SKM Power Tools for Windows is 

the most popular software that industry used for the analysis power system network.  

Planning on how to modeling the system is an important part before use the software.  It 

is because a different software have a different requirement. 
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CHAPTER 3 

 

 

 

 

METHODOLOGY 

 

 

 

 

3.1 Introduction 

 

 

  This chapter will explain about the method used for this project.  It also discuss 

on how to model and simulate the trial system by using SKM Power Tools for Windows. 

After doing the trial, the same way will be implemented to the real system of Petronas 

Gas Kerteh. 
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3.2 Flow Chart of the Project 

 

 

Figure 3.1 Flow Chart of the Project
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3.3 Software Usage ( SKM POWER TOOLS for WINDOWS ) 

 

 

 When start a new project, first set the application options to ensure that working 

with the correct engineering standard and units of measurement. 

 

 

3.3.1 Start Power* Tools for Windows (PTW) 

 

 

To start PTW, the PTW32 icon was clicked.  Make sure that no project are open 

by clicking Project>Close. Then click the Project>New command. 

 

 

Figure 3.2        Using the Project>New command 

 

 

3.3.2 Build a System 

 

 

PTW provide two building tools which use to create Projects: the One-line 

Diagram, which use to build the electrical system and the Component Editor which use 

to enter component data. 

 

The Tutorial in the Project Name bon was typed and the Save button was clicked. 
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Figure 3.3      Create the Tutorial Project 

 

A Project will build using One-Line Diagram when One-Line Diagram and 

Component Editor dialog box appear.A component was added by clicking one of the 

component buttons on the toolbar.  The components will arrange like an actual single 

line diagram for the system. 

 

 

 

Figure 3.4      Toolbar Icon 

 

Then, several components and their connection was entered on the one-line diagram.  
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3.3.3 Enter Component Data  

 

 

To enter the component data, double clicking left mouse button on the component then 

Component Editor will appear.  All the necessary value was entered. 

 

i. Bus Data 

 

Double click left mouse button on the bus symbol for BUS-0001.  The dialog 

window will appear.  Insert the suitable value. 

 

 

Figure 3.5        Enter voltage for bus 

 

ii. Cable Data 

 

The type of cable was selected from the library.  After the cable linked to 

the library, the description and impedance fields are grey indicating that 

the values are referenced from the library.  To edit this values locally  

break the link with the library by un-checking the Link to the Lib check 

box. 
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Figure 3.6      Select type of Cable 

 

 

 

Figure 3.7      Enter Cable Size and Length 
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iii Transformer Data Input 

 

Type of transformer was selected from the Library.  If the data in this library 

is not available, we can create our own library.  Here, 1000 in the Nominal 

kVA was selected after select type of transformer from the library.  This is 

also screen where we would change the connections, taps and voltage ratings.   

 

 

Figure 3.8      Specify the Transformer Size 

 

iv Utility Data Input 

 

The Utility Component UTIL-0001 was entered and entered the data as 

shown in figure below.  The available utility fault contribution can be entered 

in MVA, KVA, Amps or as an equivalent per unit impedance.  The per unit 

voltage can be used to control pre-fault voltage and load flow source voltage 

in front of or behind the utility impedance.  The equivalent per unit 

impedance display will be updated when the component is saved. 
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Figure 3.9      Utility fault contribution and voltage entry 

 

v Load Data Input 

 

 

 

Figure 3.10      Load data entry 
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After all of the component data was inserted, the Component Editor 

(Document>Close) was closed. Check input data with using the data block display. 

With the One-Line displayed, the Run>Datablock Format was selected. 

 

Then, the Input Data>Apply>Close button was selected.  The sample Input 

Data format will display selected input data field next to each component on the one-

line.  The data block display can be removed using the View>Datablock menu option or 

by using the Tonggle Datablock Icon. 

 

vi Run System Studies 

 

When the data was matches, the Run>Balanced System studied menu option for 

each study was selected. 

 

 

Figure 3.11 Running system studies on the power system network 

 

Once study menu that appears allows you to select the studies to be run, 

enter report names and specify solution options for each study.  The type was 

selected as shown in figure below.  If one or more of the study options are 

grayed-out and not available in your licensed version, you can continue with the 
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tutorial but recognize you may need to substitute reports and data block 

references in the rest of the tutorial with reports and data blocks for the studies 

you have run. 

 

 

 

Figure 3.12 Study selection and setup screen 

 

The Study Message window will appear while the studies are running and 

will remain on the screen after the studies are complete.  Review the study log to 

make sure there are no Fatal Errors reported.  Fatal Error will occur if some 

critical data are missing from the input data.  Click on the Close button to close 

the Study Message Window. 
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Figure 3.13 Study Message Window 

 

If errors are reported, the Edit Errors button was clicked to display the components 

that cause the errors. 

 

 

3.4 Review Study Results 

 

 

 

There are several ways to review results and the methods that choose to use for 

the projects will depend upon the stage of the project and the personal preferences of the 

people involved. 

 

1. To view a report, go to the Document>Report menu. Open dialog box will 

appear. Choose one report file for each study that run and open it. 

2. The multi-page study report will appear. The study reports are individual text 

files stored in the project folder. 

 

 

 



38 

 

3.5 Summary 

 

  

 

Figure 3.14      Flow-chart of software usage  

 

          This system can use until the maximum number of bus is 50 bus.  The same way 

on how to use the system are implemented for the real system of Petronas Gas Kerteh. 

 



 

 

 

 

CHAPTER 4 

 

 

 

 

RESULT AND DISCUSSION 

 

 

 

 

4.1 Introduction 

 

 

Petronas Gas power flow analysis has done by using SKM Power Tools for 

Window. Before doing the analysis on the real single line diagram, we do some trial for 

a simple single line diagram. The purpose of doing this analysis is to make sure that the 

analysis from the software is same with the real condition. This train system analysis is 

done also to make sure that the requirement for the other system that we used is correct. 

Two trial analysis is done. For diagram 4.1, the basic system is from tutorial book. The 

other analysis is to compare when we used the motor. For the real system of Petronas 

Gas, it will show in this analysis and the result also shows the different when the 

generator is used. 

 

 

4.2 Trial System 

 

 

Figure 4.1 shows the single line diagram for trial system analysis which has done 

from the manual book of SKM Power Tools for Windows. From the result, it shows that 

the value for real power and reactive power when the simulation is running. 

 



 

 

Figure 4.1 Trial system form manual book 

 

 

Table 4.1 : 4-Bus Branch Data 

 

No From Bus To Bus Real Power ( kW) Reactive Power ( kVar) 

1 1 2 63.9 48.5 

2 2 3 63.9 48.2 

3 3 4 63.8 47.5 

 

 

UTIL-0001

63.9 kW
48.5 kVAR

BUS-0001

13800 V
0.03 % VD

S

XF2-0001

63.9 kW
48.5 kVAR
PctVD 0.3 %

BUS-0002

4160 V
0.37 % VD

S

XF2-0002

63.9 kW
48.2 kVAR
PctVD 0.6 %

BUS-0003

480 V
0.97 % VD

CBL-0001

63.8 kW
47.5 kVAR
PctVD 0.7 %
LF 97 A

BUS-0004

480 V
1.63 % VD

LOAD-0001

95.000 Amps



Figure 4.2 shows the single line diagram for trial system analysis which have a 

motor. For this analysis, the result for real power and  reactive power is different when 

motor starting and motor running. When motor starting, the value for real power and 

reactive power is larger than motor running. It is because, motor starting needs more 

power to start the machine. Figure 4.2 will shows the result of the simulation.  

 

 

Figure 4.2 Trial system when have a motor 

 

  

 

 

 

 

 

UTIL-0001

300.1 kW
633.4 kVAR

BUS-0001

13800 V
0.33 % VD

S

XF2-0001

300.1 kW
633.4 kVAR
PctVD 3.9 %

BUS-0002

4160 V
4.23 % VD

S

XF2-0002

261.7 kW
580.1 kVAR
PctVD 6.5 %

BUS-0003

480 V
10.70 % VD

CBL-0001

252.9 kW
536.8 kVAR
PctVD 3.6 %
LF 799 A

BUS-0004

480 V
14.33 % VD

LOAD-0001

95.000 Amps
MTRI-0001

100.000 hp

S

XF2-0003

33.4 kW
25.3 kVAR
PctVD 0.9 %

BUS-0005

240 V
5.13 % VD

LOAD-0002

100.000 Amps



Table 4.2 : Real Power and Reactive Power when motor starting and running 

 

 No From bus To bus Motor Running Motor Starting 

    ( kW)   ( kVar)    ( kW)   ( kVar) 

  1   1 2     195.0    151.1    300.1    633.4 

  2   2 3     160.9    122.3    261.7    580.1 

  3 5      33.4     25.3     33.4    25.3 

  4   3 4     160.8    118.2    252.9    536.8 

 

 

4.3 Result Power Flow Analysis for real System ( Petronas Gas ) 

 

 

This single line diagram is come from Petronas Gas Kerteh.  This system actually 

have 1 utility, 3 generator, 64 buses, 41 cables, 22 2-winding transformer, 14 general 

loads and 12 motors. The system have been simplified because the software in the 

University Malaysis Pahang is limited. The maximum bus is 50. After re-design, the 

system only have 48 buses. Below is the diagram and result for bus and branch data. 

From the result that at table 4.3 and table 4.3, there have some different between the real 

system because we already re-design the single-line diagram to fulfill the requirement of 

the software. The full result of this new real system single-line diagram shown in 

Appendix C. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Figure 4.3 Real System Single Line Diagram 

 

UTIL-0001

25589.9 kW
12349.1 kVAR

BUS-0001

132000 V
0.33 % VDCBL-0001

25589.9 kW
12349.1 kVAR
PctVD 0.0 %
LF 125 A

BUS-0002

132000 V
0.36 % VDCBL-0002

25584.0 kW
12338.2 kVAR
PctVD 0.0 %
LF 125 A

BUS-0003

132000 V
0.36 % VD

S

XF2-0001

25583.9 kW
12338.1 kVAR
PctVD 2.9 %

BUS-0004

33000 V
3.22 % VD

CBL-0003

25527.8 kW
10464.1 kVAR
PctVD 0.0 %
LF 499 A

BUS-0005

33000 V
3.22 % VD

CBL-0004

3819.7 kW
3068.9 kVAR
PctVD 0.0 %
LF 89 A

BUS-0006

33000 V
3.22 % VD

S

XF2-0003

3819.6 kW
3068.7 kVAR
PctVD -3.2 %

BUS-0007

11000 V
0.03 % VD

CBL-0005

3816.2 kW
2979.2 kVAR
PctVD 0.0 %
LF 254 A

BUS-0008

11000 V
0.03 % VD

CBL-0006

563.1 kW
436.7 kVAR
PctVD 0.0 %
LF 37 A

BUS-0009

11000 V
0.06 % VD

S

XF2-0004

562.8 kW
436.5 kVAR
PctVD -2.7 %

BUS-0010

415 V
-2.60 % VD

CBL-0007

560.5 kW
420.8 kVAR
PctVD 0.2 %
LF 950 A

BUS-0011

415 V
-2.44 % VD

LOAD-0001

100.000 kVA

CBL-0008

563.5 kW
436.9 kVAR
PctVD 0.0 %
LF 37 A

BUS-0012

11000 V
0.06 % VD

S

XF2-0005

563.3 kW
436.8 kVAR
PctVD -2.7 %

BUS-0013

415 V
-2.60 % VD

CBL-0009

561.0 kW
421.0 kVAR
PctVD 0.2 %
LF 951 A

BUS-0014

415 V
-2.44 % VD

LOAD-0002

100.000 kVA

CBL-0010

401.6 kW
308.4 kVAR
PctVD 0.0 %
LF 27 A

BUS-0015

11000 V
0.03 % VD

S

XF2-0006

401.6 kW
308.4 kVAR
PctVD -3.2 %

BUS-0016

415 V
-3.12 % VD

CBL-0011

400.4 kW
300.5 kVAR
PctVD 0.1 %
LF 675 A

BUS-0017

415 V
-3.00 % VD

LOAD-0003

100.000 kVA

CBL-0012

522.1 kW
927.3 kVAR
PctVD 0.0 %
LF 56 A

BUS-0018

11000 V
0.04 % VD

S

XF2-0007

522.0 kW
927.2 kVAR
PctVD -1.1 %

BUS-0019

415 V
-1.06 % VD

CBL-0013

516.8 kW
892.2 kVAR
PctVD 0.3 %
LF 1419 A

BUS-0020

415 V
-0.81 % VD

LOAD-0004

200.000 kVA

CBL-0014

2246.4 kW
1757.9 kVAR
PctVD 0.0 %
LF 150 A

BUS-0021

11000 V
0.04 % VD

S

XF2-0008

2246.1 kW
1757.6 kVAR
PctVD -2.7 %

BUS-0022

3300 V
-2.61 % VD

CBL-0015

2240.5 kW
1680.3 kVAR
PctVD 0.0 %
LF 477 A BUS-0023

3300 V
-2.59 % VD

CBL-0016

3819.5 kW
3068.3 kVAR
PctVD 0.0 %
LF 89 A

BUS-0024

33000 V
3.22 % VD

S

XF2-0009

3819.4 kW
3068.1 kVAR
PctVD -3.2 %

BUS-0025

11000 V
0.03 % VD

CBL-0017

3816.0 kW
2978.7 kVAR
PctVD 0.0 %
LF 254 A

BUS-0026
11000 V
0.03 % VD

CBL-0018

2246.4 kW
1758.0 kVAR
PctVD 0.0 %
LF 150 A

BUS-0027

11000 V
0.04 % VD

S

XF2-0010

2246.0 kW
1757.7 kVAR
PctVD -2.7 %

BUS-0028

3300 V
-2.61 % VD

CBL-0019

2240.4 kW
1680.5 kVAR
PctVD 0.0 %
LF 477 A

BUS-0029

3300 V
-2.59 % VD

CBL-0020

401.6 kW
308.5 kVAR
PctVD 0.0 %
LF 27 A

BUS-0030

11000 V
0.03 % VD

S

XF2-0011

401.6 kW
308.5 kVAR
PctVD 1.1 %

BUS-0031

415 V
1.17 % VD

CBL-0021

400.4 kW
300.5 kVAR
PctVD 0.1 %
LF 705 A

BUS-0032

415 V
1.29 % VD

LOAD-0007

100.000 kVA

CBL-0022

401.6 kW
308.5 kVAR
PctVD 0.0 %
LF 27 A

BUS-0033

11000 V
0.03 % VD

S

XF2-0012

401.6 kW
308.5 kVAR
PctVD 1.1 %

BUS-0034

415 V
1.17 % VD

CBL-0023

400.4 kW
300.5 kVAR
PctVD 0.1 %
LF 705 A

BUS-0035

415 V
1.29 % VD

LOAD-0008

100.000 kVA

CBL-0024

285.9 kW
284.4 kVAR
PctVD 0.0 %
LF 21 A

BUS-0036

11000 V
0.03 % VD

S

XF2-0013

285.8 kW
284.4 kVAR
PctVD -0.8 %

BUS-0037

415 V
-0.72 % VD

CBL-0025

285.1 kW
289.5 kVAR
PctVD -0.1 %
LF 561 A

BUS-0038

415 V
-0.81 % VD

LOAD-0009

200.000 kVA

MTRI-0001

600.000 kVA

MTRI-0002

600.000 kVA

MTRI-0003

400.000 kVA

MTRI-0004

300.000 kVA

MTRI-0006

1900.000 kVA

MTRI-0007

1900.000 kVA

MTRI-0008

400.000 kVA

MTRI-0009

400.000 kVA

MTRI-0010

300.000 kVA

FLTR-0001

S

TR-A

11127.2 kW
12071.3 kVAR
PctVD -1.2 %

BUS-0039
11000 V
4.46 % VD

GEN-0001
11127.2 kW
12071.3 kVAR

S

TR-B
11127.2 kW
12071.3 kVAR
PctVD -1.2 %

BUS-0040
11000 V
4.46 % VD

GEN-0002
11127.2 kW
12071.3 kVAR

S

TR-C
11127.2 kW
12071.3 kVAR
PctVD -1.2 %

BUS-0041
11000 V
4.46 % VD

GEN-0003
11127.2 kW
12071.3 kVAR

CBL-0026

3204.5 kW
2497.5 kVAR
PctVD 0.0 %
LF 73 A

BUS-0042

33000 V
3.22 % VD

S

XF2-0014

3204.5 kW
2497.5 kVAR
PctVD -2.8 %

BUS-0043

11000 V
0.37 % VD

CBL-0027

3200.2 kW
2400.7 kVAR
PctVD 0.0 %
LF 211 A

BUS-0044
11000 V
0.37 % VD

CBL-0028

80.1 kW
60.5 kVAR
PctVD 0.0 %
LF 5 A

BUS-0045

11000 V
0.38 % VD

S

XF2-0015

80.1 kW
60.5 kVAR
PctVD -3.9 %

BUS-0046

415 V
-3.56 % VD

CBL-0029

80.0 kW
60.0 kVAR
PctVD 0.0 %
LF 134 A

BUS-0047
415 V
-3.52 % VD

LOAD-0010
100.000 kVA

LOAD-0011
400.000 kVA

MTRI-0011
3500.000 kVA

MTRI-0012
50000.000 kVA

CBL-0030

8000.1 kW
6000.1 kVAR
PctVD 0.0 %
LF 181 A

BUS-0048

33000 V
3.22 % VD

LOAD-0012

10000.000 kVA

LOAD-0006

900.000 kVA

PI-0010

480.5 kW
888.0 kVAR
Volt  Drop -0.0 %

PI-0011
0.1 kVAR
Volt  Drop -0.0 %

PI-0012
115.1 kW
590.2 kVAR

PI-0013
0.2 kW
0.1 kVAR
Volt  Drop -0.0 %



 

 

Figure 4.4 Real System (a) 



 

 

Figure 4.5  Real System (b) 

 

 

4.3.1 Bus Data 

 

 

 

Table 4.3 : Bus Data 

 

No  Bus Name Base Volt ( kV )  PU Volt 

1 0001 132 0.9960 

2 0002 132 0.9955 

3 0003 132 0.9955 

4 0004 33 0.9667 

5 0005 33 0.9666 

6 0006 33 0.9666 

7 0007 11 0.9985 



8 0008 11 0.9985 

9 0009 11 0.9981 

10 0010 0.415 1.0247 

11 0011 0.415 1.0231 

12 0012 11 0.9981 

13 0013 0.415 1.0247 

14 0014 0.415 1.0231 

15 0015 11 0.9985 

16 0016 0.415 1.0299 

17 0017 0.415 1.0287 

18 0018 11 0.9984 

19 0019 0.415 1.0094 

20 0020 0.415 1.0068 

21 0021 11 0.9983 

22 0022 3.3 1.0248 

23 0023 3.3 1.0246 

24 0024 33 0.9666 

25 0025 11 0.9985 

26 0026 11 0.9985 

27 0027 11 0.9983 

28 0028 3.3 1.0248 

29 0029 3.3 1.0246 

30 0030 11 0.9984 

31 0031 0.415 0.9871 

32 0032 0.415 0.9858 

33 0033 11 0.9984 

34 0034 0.415 0.9871 

35 0035 0.415 0.9858 

36 0036 11 0.9984 

37 0037 0.415 1.0059 

38 0038 0.415 1.0068 

39 0039 11 0.9552 

40 0040 11 0.9552 

41 0041 11 0.9552 

42 0042 33 0.9666 

43 0043 11 0.9950 

44 0044 11 0.9950 

45 0045 11 0.9950 

46 0046 0.415 1.0343 

47 0047 0.415 1.0339 

48 0048 33 0.9666 



4.3.2 Branch Data 

 

 

Table 4.4 : Branch Data 

No  From Bus  To Bus  P ( kW)  Q ( kVar)  % VD  

1 0001 0002 44294.6 13459.1 0.05 

2 0002 0003 44278.8 13429.9 0.00 

3 0003 0004 44278.6 13429.7 2.88 

4 0004 0005 44129.3 8447.5 0.00 

5 0005 0006 3819.7 3069.3 0.00 

6 0024 3819.6 3068.8 0.00 

7 0042 3204.5 2497.8 0.00 

8 0048 8000.1 6000.1 0.00 

9 0006 0007 3916.6 3069.2 -3.19 

10 0007 0008 3816.2 2979.5 0.00 

11 0008 0009 563.1 436.7 0.04 

12 0012 563.5 436.9 0.03 

13 0015 401.6 308.4 0.00 

14 0018 521.8 925.8 0.01 

15 0021 2246.4 1758.1 0.02 

16 0009 0010 526.8 436.6 -2.66 

17 0010 0011 560.5 420.8 0.17 

18 0012 0013 563.3 436.8 -2.66 

19 0013 0014 561.0 421.0 0.17 

20 0015 0016 401.6 308.4 -3.15 

21 0016 0017 400.4 300.5 0.12 

22 0018 0019 521.7 925.8 -1.09 

23 0019 0020 516.5 890.7 0.25 

24 0021 0022 2246.1 1757.8 -2.65 



25 0022 0023 2240.5 1680.3 0.02 

26 0024 0025 3819.4 3068.6 -3.19 

27 0025 0026 3816.0 2979.0 0.00 

28 0026 0027 2246.4 1758.2 0.02 

29 0030 401.6 308.5 0.00 

30 0033 401.6 308.5 0.00 

31 0036 286.1 -282.9 0.00 

32 0027 0028 2246.1 1757.9 -2.65 

33 0028 0029 2240.4 1680.5 0.02 

34 0030 0031 401.6 308.5 1.14 

35 0031 0032 400.4 300.5 0.13 

36 0033 0034 401.6 308.5 1.14 

37 0034 0035 400.4 300.5 0.13 

38 0036 0037 286.1 -283.0 -0.75 

39 0037 0038 285.3 -288.0 -0.09 

40 0039 0005 4919.7 12520.7 -1.15 

41 0040 0005 4919.7 12520.7 -1.15 

42 0041 0005 4919.7 12520.7 -1.15 

43 0042 0043 3204.5 2497.7 -2.84 

44 0043 0044 3200.2 2400.7 0.00 

45 0044 0045 80.1 60.5 0.00 

46 0045 0046 80.1 60.5 -3.93 

47 0046 0047 80.0 60.0 0.04 

 

 

4.4 Discussion 

 

 



 After all of the analysis have done, some of the require things must be discussed.  

Load flow analysis refer to the loads, real power, reactive power, voltage p.u and also 

voltage angle at each bus and each branch.  In this real system analysis, is have some 

differences to the value of the real power and reactive power.  From the result, the value 

of real power and reactive power at bus 132kV and bus 33kV is same as the result from  

Petronas Gas. Start from bus 11kV the value of real power, reactive power, voltage angle 

and all of the data is different because the SKM Power Tools for Windows at Universiti 

Malaysia Pahang is limited. For this problem, the Petronas Gas single line diagram have 

been re-design to fulfill the requirement of the software. 

 

 Petronas Gas Kerteh have 3 generator.  At normal condition, this system only use 

2 generator.  All of this three generator use when the system make a maintenance.  This 

system also get the power from the utility that is TNB.  Bacause of the Petronas Gas 

generates their own electricity,  the generator and the utility must operate at the same 

time. If not enough power from the generator, the losses will increase. 

 

 For this software, the value of the component must be entered.  So the planning 

are require to make sure that the simulation will running.  Some of the planning are, 

suitable type of cable, suitable type of transformer that must follow the requirement of 

the software.  

 

 

4.5 Summary 

 

  

 Load flow analysis that have been done for Petronas Gas give a full result that 

related to the power flow. This analysis is important to make sure that the system always 

in a good condition. 



 

 

 

 

CHAPTER 5 

 

 

 

 

CONCLUSION AND RECOMENDATION 

 

 

 

 

5.1 Conclusion 

 

 

 The planning, design and operation of a power system require continual and 

comprehensive analysis to evaluate current system performance and to determine the 

effectiveness of alternate plans for future plant expansion.  

 

 Mathematical calculation methods were developed to study the electrical the 

electrical distribution system under some conditions.  The calculations allowed operators 

to determine how best to maximize the operations of their electrical systems. Performing 

calculations by hand methods is complex and time consuming.   

 

Software has been developed for the personal computer to relieve the system 

engineer of the repetitive, complex, and time-consuming calculations.  The engineer can 

use the time savings to better plan, design and evaluate the electrical system.  Today’s 

software is easy to use.  Software has significantly reduced the time required to perform 

system studies.   

 

Power flow is the most important of the power system study that has been 

introduced and explain detail.  Choice of a particular method in any situation is 

compromise between the various criteria of goodness of the load flow methods. 

 



If the system is very sensitive to reactive power flows, i.e. the voltages change 

considerably with change in load and network configuration, the computer program may 

diverge.  It is preferable to allow the reactive power outputs of the generators to be 

initially without limit to ensue the initial convergence.  Convergence having be attained, 

the computer evaluates the real and reactive power flow in each branch of the system, 

along with losses ,absorption of vars and any other information that may be required. 

 

 

RECOMMENDATION 

  

 

SKM Power Tools for Windows is one of the software that use for planning, 

design and analyze the electrical power system network.  The result from this analysis 

will give an accurate value base on the trial and the real system that have been used.  

This software also have more data such as transformer, cable and the other component.  

It also allow us to create our own library. 

 

Power flow is one of the most analysis that must be evaluate.  It is because from 

the power flow we can know the performance of the power system network.  Besides, 

the other analysis also important to make sure that the system become more efficient and 

more accurate.  For the future recommendation, the other analysis like transient stability, 

short circuit, arc, harmonics and other analysis must be analyze.  It is because, when 

doing more analysis, student will able to see the real of the system network.  

 

From the software and the analysis, student should able to handle the software. It 

is because most of the industry use the software and need the analysis of the power 

system network. 
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